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Principles of
operation

CatWalk is an automated gait
analysis system for rats and mice
that uses Noldus's proprietary
llluminated Footprints™ technology
to capture and quantify locomotor
behavior with high precision. The
system enables objective and
reproducible assessment of gait,
paw placement, and inter-limb
coordination, making it suitable for
both routine measurements and
longitudinal studies in preclinical
research.

The apparatus consists of an
enclosed walkway positioned on a
glass plate. Green light enters
through the long edge of the plate
and is completely internally
reflected within the glass. This light
escapes only at the points where an
animal’'s paws make contact with
the surface, producing sharply
defined illuminated footprints.

A high-speed camera mounted
beneath the walkway records these
footprints as the animal traverses
the corridor. Following a short
habituation period, animals can
generally be encouraged to cross
the walkway voluntarily, helping
minimize handling-related stress
and supporting the collection of
natural gait patterns.

The captured video images are
transferred to a computer via a 10
Gb Ethernet connection and
analysed by the CatWalk software.
The software extracts a wide range
of gait parameters, allowing
researchers to detect subtle
changes in motor function in
applications such as pain research,
nerve injury, spinal cord injury, and
neurodegenerative disease studies.
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System configurations & licensing

License types

CatWalk 11.0 is available with either
a hardware key (USB dongle) or a
software license. Software licenses
offer two modes:

¢ Fixed license — Tied to a single
computer. Deactivation required
before transferring to another
machine. May be activated
online or offline (via QR code).

¢ Floating license — Usable on
multiple computers sequentially
(not simultaneously). Requires
internet connection on the
acquisition computer. Multiple
floating licenses allow
simultaneous use.

e Perpetual license — One-time
purchase; software may be
used indefinitely.

e Time-limited license — Valid for
a defined period (typically 6 or
12 months). Online activation
only.
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Analysis mode

CatWalk can be installed on
additional computers without a
license.

In unlicensed analysis mode, users
can open experiments, classify
runs, create data and parameter
profiles, run all analysis functions,
and export all data and statistics.

New data acquisition is not
possible without a valid license.




Data management

Experimental setup

e Animal Type — Select Rat or
Mouse. Determines the
Automatic Footprint
Classification algorithm and the
Sciatic, Tibial, and Peroneal
Functional Index formulas.

e Time Points — Define and label
the time points at which data
are acquired, with optional
colour coding for group
statistics.

e Treatment Groups — Define
groups with type (Undefined,
Experimental, Control, Sham),
name, description, and display
colour.

e Run Criteria — Set minimum and
maximum run duration,
minimum number of compliant
runs to acquire, and an optional
maximum allowed speed
variation threshold. Runs not
meeting criteria are marked
non-compliant; acquisition
continues until the required
number of compliant runs is
reached.

e Trial List — Pre-plan trials with
animal ID, time point, group
assignment, and optional
description. Trial names are
unique identifiers. The list
shows acquisition status, total
runs, compliant runs, and
classification status for each
trial.

CatWalk 11 - Technical specifications

Experiment Setup Profiles —
Save and reuse a set of
experiment settings (time
points, treatment groups, trial
structure) across new
experiments.

Preferences — Distance unit
(millimetres, centimetres, or
inches), decimal precision for
numbers, times and
percentages; folder locations;
auto-save interval; paw display
colours.

File management

Experiment files — Stored as
*.cwe files within a named
experiment folder.

Backup and restore —
Experiments can be backed up
to *.cwz archives and restored
from them. Auto-save at
configurable intervals (default:
every 5 minutes).

Backward compatibility —
CatWalk 11 opens and converts
experiments from versions 8.x,
9.x, 10.x. Experiments from
versions prior to 11 are read-
only (analysis only; no new
acquisition). Experiments from
versions 7.x or earlier cannot
be opened.




Walkway setup

Setup workflow

Setting up the walkway involves
three sequential steps, each
supported by a dedicated tool:

e Focus Assist — Interactive tool
to focus the camera lens. A

sharpness indicator (percentage

of maximum reachable
sharpness) guides the user. A
bottom-image view highlights
sharp areas for real-time
feedback.

¢ Automatic Walkway Calibration

— After focusing, a dedicated
calibration card placed in the
walkway is detected
automatically. Calibration
converts pixel dimensions to
real-world units (mm/pixel).
Manual calibration is possible
but not recommended.

e Automatic Walkway Definition
— The software automatically
detects the corridor walls and
defines a walkway rectangle
covering 70% of the walkway
length. The walkway can be
resized and repositioned
manually. A Validate Walkway
function checks corridor-wall
alignment at the start of each
acquisition session.

Once set up, the walkway
configuration is retained across
sessions. Re-setup is only required
if hardware is changed (e.g.,
camera position, corridor width).

CatWalk 11 - Technical specifications

Detection settings

Auto Detection — With an
animal on the walkway,
CatWalk automatically adjusts
Camera Gain and Green
Intensity Threshold to achieve
optimal paw-print intensity
(target: Maximum Green
Intensity 197-203). Default
Detection Settings profiles for
Rats and Mice are provided.

Manual Detection — Camera
Gain and Green Intensity
Threshold can be fine-tuned
manually. The intensity of the
Green Walkway Light and Red
Ceiling Light can also be
adjusted.

Camera Gain — Controls
Maximum Green Intensity of
detected prints. Optimal range:
5-12 dB.

Green Intensity Threshold —
Sets the minimum pixel
intensity for paw detection.
Removes background noise.
Can also be adjusted per runin
the Classification screen before
classification.




Data acquisition

Acquisition procedure Acquired runs list
After snapping a background image For each run, the following
of the empty walkway, the user variables are displayed:
clicks Start Acquisition. CatWalk
automatically detects when the ¢ Run number
animal enters the camera view and e Start date and time
begins recording. e Duration
e Compliance status (with reason
A run stops automatically when the if non-compliant)
animal leaves the field of view. e Walking direction
e Run average speed
e Run maximum speed variation,
Acquisition settings : Camera gain

Green intensity threshold

e Auto-abort — Runs can be
automatically aborted if they
exceed a set duration. Runs are
always stopped at 60 seconds
maximum.

e Discard options — Separately
configure whether auto-aborted
runs, user-aborted runs, non-
compliant runs, and incomplete
prints at walkway borders are
discarded automatically.

e Sound feedback — Auditory
beeps (1 = run started, 2 = run
stopped, 3 = error) can be
enabled or disabled.
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Run
classification

Paw print classification

e Manual Classification — Users
draw boxes around prints and
assign labels: Right Front (RF),
Left Front (LF), Right Hind (RH),
Left Hind (LH), Right Hip (RM),
Right Knee (RK), Left Hip (LM),
Left Knee (LK), Nose (NO),
Abdomen (AB), Tail (TA),
Genitalia (GT). Grouping boxes
around labeled and unlabeled
prints of the same paw speeds
up labeling.

e Automatic Footprint
Classification (AFC) — Optional
add-on module. Uses the body
contour of the animal to
automatically assign paw labels.
AFC works best with a clean
glass plate, straight
uninterrupted runs, and an
animal that contacts the glass
only with its paws. Manual pre-
labeling of non-paw prints
before running AFC is
recommended. A minimum Max
Intensity threshold can be set to
filter noise.

e Green Intensity Threshold (per
run) — Can be adjusted before
classification to fine-tune paw
detection without affecting
other runs.

Classification views

e Print View — Displays all paw
prints in 2D. Available in Normal
Color, False Color (intensity
gradient green-red), and
Colorized modes. Prints can be
shown all-at-once or per frame.
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Timing View — Time-based
gait diagram. Bars represent
stance duration per paw; gaps
represent swing. Clicking a bar
jumps to the corresponding
video frame.

Numerical Results — Per-print
table with initial contact time,
stand duration, max contact
time and area, max and mean
intensity, print length, width
and area.

Error correction

Labeling errors — Reset and
re-assign labels using the Print
View or Timing View as guides.

CatWalk errors — Detected
automatically when the same
label is assigned to two paws in
the same frame. Listed in the
Video section for correction.

Print errors — Noise or non-
paw body parts included in a
paw rectangle can be corrected
by removing and re-adding
prints.

Combine stances — Two sub-
divided stances of the same
paw can be manually
combined.




Interactive footprint
measurements

This optional Interactive footprint
measurement (IFM) module is used
for detailed toe measurements on
hind paws to calculate functional
nerve recovery indices.

e Toe Spread (TS) — Distance
between the centre of the first
and fifth toe.

¢ Intermediate Toe Spread (ITS)
— Distance between the centre
of the second and fourth toe.

¢ Manual Print Length (PL) —
Distance from the centre of the
third toe to the heel.

e Paw Angle Body Axis —
Smallest angle between the
Print Length line and the body
axis.

e Paw Angle Movement Vector —
Smallest angle between the
Print Length line and the
calculated movement direction
(linear regression over four
consecutive body-contour
positions).
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Data selection

Data segmentation

profiles Parameter profiles

A Data Segmentation profile selects Parameter profiles allow selection
the portion of each classified run of specific paws and parameters
that meets three criteria: minimum for display in Run Statistics, Group
number of consecutive steps, Statistics, and export files. The
average speed range, and default All Parameters profile
maximum allowed speed variation. cannot be edited or deleted.

Multiple profiles can be created and
saved; the default All Data profile
includes all classified steps.

e Minimum number of
consecutive steps —
recommended = 10 (ensures
each paw is placed at least
twice, enabling calculation of
stride-based parameters).

e Average speed range — set in
distance units per second.

e Maximum allowed speed
variation — expressed as
percentage deviation from run
average speed.

¢ Options to exclude non-
compliant runs and/or partially
classified runs.

The Selected Data Overview shows
the proportion of animals, runs, and
steps selected per group and time
point.
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Analysis Parameters - Dependent
variables

Paw statistics

Parameter Description

Initial contact at (s) Time since run start when a paw first contacts the glass plate

Stand / Stance (s) Duration of contact of a paw with the glass plate

Stand Index Rate at which the paw loses contact with the glass plate (negative value; more
negative = faster lift). Requires = 5 frames of stance.

Max contact at (s) Time since run start at which the paw reaches maximum contact area (transition from
braking to propulsion phase).

Max contact at (%) Max Contact At expressed as a percentage of stance duration.

Max Contact Area Surface area of the paw print at Max Contact At.
|M3X Contact Max Intensity Maximum pixel intensity of the print at Max Contact (range 0-255; proxy for weight-
bearing).
[Max Contact Mean Intensity | \iean pixel intensity of the print at Max Contact.
X position Horizontal position of the paw print centre at Max Contact.
Y position Vertical position of the paw print centre at Max Contact.
Print Length Length (horizontal / walking direction) of the complete print.
Print Width Width (perpendicular to walking direction) of the complete print.
Print Area Surface area of the complete print (all stance frames combined; = Max Contact Area).

Max Contact Area Surface area of the paw print at Max Contact At.

Max intensity at (s) Time since run start at which maximum print intensity occurs.

IMaX Intensity At (%) Max Intensity At expressed as a percentage of stance duration.

IMax Intensity Maximum intensity of the complete paw print across all stance frames.

IMin Intensity Minimum intensity of the complete paw print.

IMean Intensity Mean intensity of the complete paw print.

Mean Intensity of 15 Most

Intense Pixels Mean intensity of the 15 highest-intensity pixels of the print.

Swing (s) Duration of no contact with the glass plate between two stances.

Swing speed Speed of the paw during swing (Stride Length / Swing).

Stride length Distance between successive placements of the same paw (centre-to-centre at Max
Contact).

Step Cycle (s) Time between two consecutive Initial Contacts of the same paw (Stand + Swing).

Duty Cycle (%) Stand expressed as a percentage of Step Cycle.
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Analysis Parameters - Dependent

variables

Paw statistics -

Parameter

Initial contact at (s)

continued

Description

Body Speed

Stand / Stance (s)

Single Stance

Body Speed Variation (%)

Duration during which only one hind paw contacts the glass plate (contralateral hind
paw off ground).

Initial Dual Stance

First period in a hind-paw step cycle during which both hind paws simultaneously
contact the glass.

Terminal Dual Stance

Max intensity at (s)

Second period in a hind-paw step cycle during which both hind paws simultaneously
contact the glass.

Time since run start at which maximum print intensity occurs.

IMax Intensity At (%)

Max Intensity At expressed as a percentage of stance duration.

IMax Intensity

Time since run start at which maximum print intensity occurs.

IMin Intensity

Max Intensity At expressed as a percentage of stance duration.

IMean Intensity

Time since run start at which maximum print intensity occurs.

Mean Intensity of 15 Most
Intense Pixels

Mean intensity of the 15 highest-intensity pixels of the print.

Step sequence

Parameter

Regularity Index (%)

Number of Normal Step Sequence Patterns (NSSP) x 4 / Total paw placements x
100%. Value of 100% indicates fully coordinated gait. Used in spinal cord injury
research.

Footfall Patterns

Six recognised pattern families: Cruciate A (CA), Cruciate B (CB), Alternate A (AA),
Alternate B (AB), Rotate A (RA), Rotate B (RB). Labelling is independent of which paw
starts the run.

Normal Patterns

Count of step cycles falling within one of the six recognised footfall pattern
categories.

Accounted Steps

Total number of steps used to determine footfall patterns.

Base of support

Parameter

Description

Base of Support — Front Paws

Mean Y-axis distance between the centres of the two front paws at Max Contact.

IBase of Support — Hind Paws

Mean Y-axis distance between the centres of the two hind paws at Max Contact.
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Analysis Parameters - Dependent

variables

Print positions

Parameter

Description

Print positions

Distance between the ipsilateral front and hind paw in the same step cycle (X-axis at
Max Contact). Positive = hind paw behind front paw; negative = hind paw in front of
front paw.

Other statistics

Parameter
Duration Duration of the run based on selected steps (Data Segmentation profile).
Average Speed Average speed of selected steps (distance units/second).

{Maximum Variation (%)

Maximum variation in average speed within the selected steps.

Cadence

Steps per second, calculated from Initial Contact of the first to last selected step.

Number of Steps

Total number of selected steps.

Sciatic Functional Index (SFI)

Functional recovery measure for the sciatic nerve. Uses Manual Print Length, Toe
Spread, and Intermediate Toe Spread for experimental vs. normal contralateral hind
paw. Calculated separately for rats (Bain 1989) and mice (Inserra 1998). Requires IFM
module.

Posterior Tibial Functional
Index (TFI)

Recovery measure for the tibial nerve branch. Same inputs as SFI. Requires IFM
module.

Peroneal Functional Index (PFI)

Recovery measure for the peroneal nerve branch. Uses Print Length and Toe Spread.
Requires IFM module.

Phase dispersions

Phase Dispersions describe the temporal relationship between the
placement of two paws within a step cycle, expressed as a percentage of
the anchor paw's step cycle time. Six paw-pair combinations are reported.
Range: -50% to +50% (CStat Mean). Values are circular statistics.

Parameter

Diagonal pairs

Descri|

RF-LH and LF-RH (anchor = front paw).

Girdle pairs

LF-RF and LH-RH (anchor = left paw).

Ipsilateral pairs

RF-RH and LF-LH (anchor = front paw).

CStat Mean (%)

Circular mean of phase dispersions (range -50% to +50%).

AD (Angular Deviation)

Measure of spread around the mean (equivalent to Standard Deviation in CatWalk <
10.6).

SD (Circular Standard

Alternative spread measure; ranges from 0 to oo.

Deviation)

R Length of the mean vector (0-1); higher R = greater consistency of inter-paw timing
across step cycles.

Mismatches

Count of ANT (anchor, no target), AMT (anchor, multiple targets), and TNA (target, no
anchor) occurrences.
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Analysis Parameters - Dependent

variables

Couplings

Couplings are computed the same way as Phase Dispersions but a target
can never precede its anchor; values range from 0% to 100% (CStat Mean).
Twelve paw-pair combinations are reported. The same statistics (CStat
Mean, AD, SD, R, Mismatches) are available as for Phase Dispersions.

Parameter

Support Formula

Description

Number of paws simultaneously on the glass plate in each section of a step cycle
(e.g., 2-3-2-3-2-3-2-3).

Footfall Formula

Alphanumeric notation indicating which specific paws are on the glass plate during
each section.

Standing on %

Relative duration of simultaneous contact for all combinations: zero, single, diagonal,
lateral, girdle, three, and four paws.

Group statistics

Group statistics aggregate per-trial values by treatment group and time
point combination. Available statistics: N, Mean (arithmetic or circular),
SEM, CStat Mean, CStat R, CStat AD, CStat SD.

Charts: Bar chart (mean + SEM) or Five Number Summary (box-whisker,
minimum 4 trials required). Circular charts for Phase Dispersions and
Couplings. Charts can be split by treatment group, time point, or both.

Research applications

CatWalk has been validated and applied extensively across a wide range of
preclinical research areas. The following disease models and research
areas have been studied using CatWalk gait parameters.

Research area

Spinal cord injury

Commonly affected parameters

Base of Support, Intensity, Stand, Phase Dispersions, Regularity Index, Stride Length

Neuropathic pain

Print Area, Intensity, Duty Cycle, Swing Duration, Swing Speed

Ischemia / Stroke

Swing Speed, Intensity, Duty Cycle, Phase Dispersions, Regularity Index, Stride
Length

Amyotrophic Lateral Sclerosis

Stand, Stride Length, Duty Cycle, Support on diagonal and 3 limbs

Cerebellar ataxia

Swing & Stand Duration, Regularity Index, Print Area, Stride Length, Phase Dispersion

|Motor coordination (cerebellar
cortex)

Stride Length, Duty Cycle, Swing Speed, Phase Dispersions, Support formulas

Parkinson's disease models

Average Speed, Regularity Index, Print Area, Swing Speed, Stride Length, Stand Index

Sciatic nerve injury

SFI, Paw Print Intensities, Couplings, Base of Support, Stride Length

Arthritis (mono- and
osteoarthritis)

Print Area, Mean Intensity, Duty Cycle, Regularity Index

Huntington's disease

Swing Speed, Stand

Charcot-Marie-Tooth disease

Print Length/Width, Max Contact Area, Max Intensity, Couplings

Genetic / toxic models
(Refsum, Leigh)

Print Area, Swing Speed, Stride Length, Stand Index, Regularity Index

CatWalk 11 - Technical specifications




Visualizations

e 3D Footprint Intensities — Plots
paw print intensity values (0-
255) per video frame as a
rotating 3D chart. Uses the
same false-colour scale as the
Classification Print View.

e 2D Footprint Intensities — Plots
maximum and mean intensity
for each paw print over timein a
2D chart. A vertical hairline
marks the current video
position.

e Footfall Patterns diagram —
Graphical representation of the
order in which paws were
placed. Dots are colour-coded:
blue = start of pattern, green =
within pattern, orange = not
counted, purple = not part of a
recognised pattern.
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Output and export

Export formats

Export Type Format Content

Run Data Excel (.xIsx) Raw print data per video frame (100 frames/s): X/Y
position, print dimensions, min/max/mean intensity —
per paw, per frame.

Run Statistics Excel (.xIsx) Summary statistics per run (one row per run).
Selectable parameter categories and statistics (mean,
SD).

Trial Statistics Excel (.xIsx) Combined statistics across all runs in a trial (one row

per trial). Weighted averages.

Group Statistics Excel (.xIsx) Statistics per treatment group x time point
combination (one sheet per parameter group).

Group Charts PDF All charts in Graphical Results exported to a single
PDF file. Individual charts: PNG.

Run Visualizations AVI (uncompressed) 3D/2D Footprint Intensities and Footfall Patterns
exported as video at selectable playback speed. No
codec required.

Run Video AVI (uncompressed) Raw run video with optional overlay of labels,
rectangles, and time/frame information.

All exports include metadata columns: Experiment, Group, Group Type,
Group Description, Animal ID, Time Point, Trial, Run, walkway dimensions,
pixel calibration values, Camera Gain, and Green Intensity Threshold. Units
are included in all parameter labels as of CatWalk 11.
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Hardware and system requirements

Minimum set-up

e CatWalk 11 software with valid license

e CatWalk system hardware (walkway, glass plate, green LED illumination,
illuminated ceiling with red LEDs, CatWalk Control Unit)

e Basler high-speed camera (1920 x 1216 pixels, pre-configured)

e Computer with USB-C port (for Control Unit connection) and 10 Gb
Ethernet PCle card (for camera connection)

Optional components

¢ Goal box (to motivate the animal to cross the walkway)
¢ Noldus goal box with sliding door
« Diffusion plate (fits on top of corridor walls to prevent rearing)

e Calibration card (included with CatWalk 11)
Camera specifications

Type Brand / Model Interface Connection Frame Rate

GigE Basler (10 GigE) Basler Pylon Runtime 10 Gb Ethernet PCle card 100 fps

CatWalk control unit

¢ Connected to the walkway, camera, and illuminated ceiling.

¢ Connected to the CatWalk computer via USB-C cable (requires a USB-C
port on the computer).

¢ Controls green walkway LED light (adjustable voltage) and red ceiling
LED light (adjustable voltage).

¢ Firmware upgradeable from within CatWalk software.
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System requirements

Operating system

¢ Windows 10 Pro, version 22H2 or later
e Windows 11 Pro

Administrator rights required for installation. Do not run CatWalk for the first
time as an administrator on a multi-user computer.

Recommended computer configuration

Tested System Dell Precision T3660
Processor (CPU) Intel Core i7-11700, 8-core, 2.5-4.9 GHz, 16 MB cache
{Memory (RAM) 16 GB DDR5 (minimum requirement)
Primary hard disk M.2 256 GB PCle NVMe SSD
Secondary hard disk 3.5-inch 1 TB SATA (7200 rpm) for experiment storage
Graphics card (GPU) NVIDIA Quadro T1000, 4 GB
USB port USB-C (required for Control Unit connection)
Network interface 10 Gb Ethernet PCle card (required for camera connection; included if ordering
computer from Noldus)

Camera connection

e A dedicated 10 Gb (gigabit) Ethernet PCle network interface card is
required for connecting the digital camera.

o Driver installation is included in the CatWalk 11 installer.

¢ Basler Pylon Runtime is included in the CatWalk 11 installer (replaces the
legacy Pleora eBUS driver of previous versions).

e After starting the computer and turning on the Control Unit, allow
approximately 1-2 minutes for the camera to be detected.
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Help features

e PDF Reference Manual — The complete CatWalk 11.0 Reference Manual
is accessible from the Help menu (F1).

o Tutorial videos — Video tutorials are installed on the computer and
accessible from the Help menu.

e Quick Start Guide — Step-by-step guide for setting up, acquiring, and
analysing a first experiment.

e Assembly Instructions — Separate document for assembling the
CatWalk hardware and goal box.

e Sample Experiments — Three sample experiments (with mouse and rat
data) are provided. Accessible via File > Restore Backup.

¢ Noldus Help Desk — 24-hour support across multiple time zones.
Contact via my.noldus.com. PC report utility available on request.

¢ Online Knowledge base — Searchable database of customer questions
and support answers at my.noldus.com. This knowledge base is
supported by our online chatbot which can help you find the answers
you need to frequently asked questions.
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For more information or contact please contact your
local account manager of visit our website

International headquarters North American headquarters
Noldus Information Technology bv Noldus Information Technology Inc.
Wageningen, The Netherlands Leesburg, VA, USA

Phone: +31-317-473300 Phone: +1-703-771-0440

E-mail: contact@noldus.com Toll-free: 1-800-355-9541

E-mail: info@noldus.com

Due to our policy of continuous product improvement, information in this
document is subject to change without notice. EthoVision is a registered
trademark of Noldus InformationTechnology bv. © 2025 Noldus Information
Technology bv. All rights reserved.
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	Cadence
	Steps per second, calculated from Initial Contact of the first to last selected step.

	Number of Steps
	Total number of selected steps.

	Sciatic Functional Index (SFI)
	Functional recovery measure for the sciatic nerve. Uses Manual Print Length, Toe Spread, and Intermediate Toe Spread for experimental vs. normal contralateral hind paw. Calculated separately for rats (Bain 1989) and mice (Inserra 1998). Requires IFM module.

	Posterior Tibial Functional Index (TFI)
	Recovery measure for the tibial nerve branch. Same inputs as SFI. Requires IFM module.

	Peroneal Functional Index (PFI)
	Recovery measure for the peroneal nerve branch. Uses Print Length and Toe Spread. Requires IFM module.


	Phase dispersions
	Parameter
	Description
	Diagonal pairs
	RF–LH and LF–RH (anchor = front paw).

	Girdle pairs
	LF–RF and LH–RH (anchor = left paw).

	Ipsilateral pairs
	RF–RH and LF–LH (anchor = front paw).

	CStat Mean (%)
	Circular mean of phase dispersions (range −50% to +50%).

	AD (Angular Deviation)
	Measure of spread around the mean (equivalent to Standard Deviation in CatWalk ≤ 10.6).

	SD (Circular Standard Deviation)
	Alternative spread measure; ranges from 0 to ∞.
	Length of the mean vector (0–1); higher R = greater consistency of inter-paw timing across step cycles.

	Mismatches
	Count of ANT (anchor, no target), AMT (anchor, multiple targets), and TNA (target, no anchor) occurrences.



	Analysis Parameters - Dependent variables
	Couplings
	Parameter
	Description
	Support Formula
	Number of paws simultaneously on the glass plate in each section of a step cycle (e.g., 2–3–2–3–2–3–2–3).

	Footfall Formula
	Alphanumeric notation indicating which specific paws are on the glass plate during each section.

	Standing on %
	Relative duration of simultaneous contact for all combinations: zero, single, diagonal, lateral, girdle, three, and four paws.


	Group statistics
	Research applications
	Research area
	Commonly affected parameters
	Spinal cord injury
	Base of Support, Intensity, Stand, Phase Dispersions, Regularity Index, Stride Length

	Neuropathic pain
	Print Area, Intensity, Duty Cycle, Swing Duration, Swing Speed

	Ischemia / Stroke
	Swing Speed, Intensity, Duty Cycle, Phase Dispersions, Regularity Index, Stride Length

	Amyotrophic Lateral Sclerosis
	Stand, Stride Length, Duty Cycle, Support on diagonal and 3 limbs

	Cerebellar ataxia
	Swing & Stand Duration, Regularity Index, Print Area, Stride Length, Phase Dispersion

	Motor coordination (cerebellar cortex)
	Stride Length, Duty Cycle, Swing Speed, Phase Dispersions, Support formulas

	Parkinson's disease models
	Average Speed, Regularity Index, Print Area, Swing Speed, Stride Length, Stand Index

	Sciatic nerve injury
	SFI, Paw Print Intensities, Couplings, Base of Support, Stride Length

	Arthritis (mono- and osteoarthritis)
	Print Area, Mean Intensity, Duty Cycle, Regularity Index

	Huntington's disease
	Swing Speed, Stand

	Charcot-Marie-Tooth disease
	Print Length/Width, Max Contact Area, Max Intensity, Couplings

	Genetic / toxic models (Refsum, Leigh)
	Print Area, Swing Speed, Stride Length, Stand Index, Regularity Index



	Visualizations
	Output and export
	Export formats
	Export Type
	Format
	Content
	Run Data
	Excel (.xlsx)
	Raw print data per video frame (100 frames/s): X/Y position, print dimensions, min/max/mean intensity — per paw, per frame.

	Run Statistics
	Excel (.xlsx)
	Summary statistics per run (one row per run). Selectable parameter categories and statistics (mean, SD).

	Trial Statistics
	Excel (.xlsx)
	Combined statistics across all runs in a trial (one row per trial). Weighted averages.

	Group Statistics
	Excel (.xlsx)
	Statistics per treatment group × time point combination (one sheet per parameter group).

	Group Charts
	PDF
	All charts in Graphical Results exported to a single PDF file. Individual charts: PNG.
	Run Visualizations
	AVI (uncompressed)
	3D/2D Footprint Intensities and Footfall Patterns exported as video at selectable playback speed. No codec required.

	Run Video
	AVI (uncompressed)
	Raw run video with optional overlay of labels, rectangles, and time/frame information.




	Hardware and system requirements
	Minimum set-up
	Optional components
	Camera specifications
	Type
	Brand / Model
	Interface
	Connection
	Frame Rate
	GigE
	Basler (10 GigE)
	Basler Pylon Runtime
	10 Gb Ethernet PCIe card
	100 fps


	CatWalk control unit

	System requirements
	Operating system
	Recommended computer configuration
	Tested System
	Dell Precision T3660

	Processor (CPU)
	Intel Core i7-11700, 8-core, 2.5–4.9 GHz, 16 MB cache

	Memory (RAM)
	16 GB DDR5 (minimum requirement)

	Primary hard disk
	M.2 256 GB PCIe NVMe SSD

	Secondary hard disk
	3.5-inch 1 TB SATA (7200 rpm) for experiment storage

	Graphics card (GPU)
	NVIDIA Quadro T1000, 4 GB

	USB port
	USB-C (required for Control Unit connection)

	Network interface
	10 Gb Ethernet PCIe card (required for camera connection; included if ordering computer from Noldus)


	Camera connection

	Help features
	For more information or contact please contact your local account manager of visit our website

	www.noldus.com

